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1.Giris

Bu dokiimanda Ethernet/IP opsiyon modiilii 3G3AX-MX2-EIP-A ile Omron 3G3MX2
invertéor ve NJ501-1500 arasinda Ethernet/IP haberlesme saglanmasi i¢in gerekli
konfigiirasyonlarin yapilmasi ve bu ag flizerinden invertdore run verme, frekans

degistirme, okuma/yazma islemleri gergeklestirilecek; resimlerle anlatilacaktir.

2. 3G3AX-MX2-EIP-A ve montaj1

3G3AX-MX2-EIP-A opsiyon karti 3G3MX2 ile Ethernet/IP tlizerinden haberlesme
saglanmas1 icin gerekli bir donanimdir. Invertdr iizerine sonradan monte edilir.
Uzerinde 4 adet LED indikatorii haberlesme ve c¢alisma durumu hakkinda bilgi verir.
Giiriiltiiden etkilenmemesi icin topraklama kablosu da mevcuttur. Uzerinde 2 adet RJ45

ethernet/ip portu haberlesme giris/¢ikis hatlari i¢in kullanilir.
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MX2 invertorler (MX2-A ) EN60204-1, stop category 0 standardina gére gulvenlik
ozelliklerini karsilar (1ISO 13849-1). 3G3AX-MX2-EIP-A opsiyon karti herhangi bir glivenlik aygiti

degildir, herhangi bir glvenlik protokollini yerine getirmez ancak MX2 invertorlerin guvenlik

fonksiyonunun galismamasi igin herhangi bir etki de etmez.
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MX2-NJ501 Ethernet/Ip haberlesme vapist asagidaki gibidir:

EtherMNet/IP Master \

Y

MX2-A T Inverter
+

PLc (C——1

T =
A

Option Board

PC

Slave

Ethernet network

3G3AX-MX2-EIP-A opsiyon kart1 genel dzellikleri:

Item Specification
Installation Unit type M¥2 Series Option Board
Model IGIAN-MK2-EIP-&
Dimensions (W x H x D) B8 x 58 x 45 mm
Weight 170g (typical)
Environment |Ambient ocperating temperature -10 to 50*C (no icing or condensation)
Ambient operating humidity 20 o B0%RH

Ambient storage temperature

-20 to 85°C (no icing or condensation)

‘Vibration resistance

5.9 mis2 (0.63) at 10...55 Hz

Dielectric strength

500 VAC (between isolated circuits)

EMC compliance (CE) and Elec-
trical safety standards

EMEG1800-3: 2004 (2004/108/EC) Second environment, Category
c3

EMB1800-5-1: 2007 (2008/85/EC) SELV

cUlLus compliance

Documented by UL in file E347728

Enclosure rating IP 20
EtherMet Communications protocol EtherMetIP
Interface (- pifestion EtherMet/IP Conformance Tested (ODVA)
EtherMet/IP Profile AC Drive (0x02)
Supported connections Remaote [/0: Master-Slave connection
Cos
Cyclic
Explicit Messages, UCMM and Class3
Conform fo EtherMet/IP specifications
Announce-based DLR
Communications ports 2
Communication speed 10 and 100 Mbps. Full and half duplex. Auto negotiation (default)
or forced speed/duplex.
EtherNet/IP Supported Assemblies Basic Remote 10 (Output assembly 20, Input assembly T0)
Configuration Extended Speed 10 (21, 71)

Extended Speed and Torque Contreld (123, 173)

Special 10 (100, 150)

Extended Control 10 (101, 151)

Extended Control 12 and Multi fumction 1O monitor (101, 153)
Flexible Format (138, 158)

Extended Speed and Acceleration Control (110, 111)

Depending on the MX2-A] inverter model (see below)
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Bu opsiyon kartinin 3G3MX2 siiriiciive takilmasi su sekilde olmalidir:

TOPRAKLAMA KABLOSL
BAGLANTISI UNUTULMAMALIDIR!

Step 4 If removed in Step 2, mount the termi-
nal cover again and tighten the
screw(s).

sURLICU UZERINDEN
TERMIMAL KAPAGIMI
SOKUNUZ

Step 5 Push the Option Board into the previ-
ous location of the option board cover
until it clicks into place

OPSIYON KARTINI YERLESTIRIN

VE SAGLAMLIK iGN co—
VIDALAYIN

“At work for a better life, a better world for all...”
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Uzerindeki 4 adet Led’in (MS, NS, LA1, LA2) anlamlarii su sekildedir:

Indicator Colour | Status Meaning
MS Mot Lit = Power is not supplied to the Option Board
(Module status) = Option Board is being reset
Green | Lit Normal operation. Established /O connec-

tion in RUN mode.

Flashing |+ No IfO connection
= /O connection in IDLE

Red Lit Unrecoverable fault:

- Option Board hardware error
- Unsupported Inverter version

Flashing | Recoverable fault:

= |P address conflict

= lllegal Flexible configuration

= Option Board parameters out of range or
cannot be read

= Option Board detects consecutive com-
munication errors

Indicator Colour | Status Meaning
NS Mot lit = Power not supplied (check Module Status
(Network status) LED)
=+ Mo IP address configured
Green |Lit CIP connection established (any transport
class. No timed out Exclusive Owner con-
nection.

Flashing |IP address configured and No CIP connec-
tions established

Red Lit = Duplicate IP address detected
Flashing |Exclusive owner connection timed out
LA1, LAZ Mot lit = Power not supplied (check Module Status
(Link Activity 1, 2) LED)
= Mo link established
Green | Lit Link established, 100 Mb
Flickering | Activity, 100 Mb
Yellow | Lit Link established, 10 Mb

Flickering | Activity, 10 Mb

3. 3G3MX2 invertdr parametre ayarlari

P185 parametresinden Ip adresi tanimlanir (192.168.250.XXX). Buradaki XXX degeri
1-127 arasinda girilmelidir.
P186 parametresinden haberlesme hizi 0 (Automatic) olarak segilir.

C102 parametresinden Reset girigi/butonu 3 (Resetting only trip) olarak ayarlanir.

“At work for a better life, a better world for all...”
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Param Description

Setting

PO44 | MNetwork Emor Timer

Communication watchdog timer while running.

Note additional to EtherMet/IP inactivity / watch-
dog timer.

010 9999 in 0.1 s unit. Set to 0 to disable.

PO45 | Action on Metwork
Error

Set to 0 for inverter trip (Default)
Set to 1 for deceleration and trip
Set to 2 for no action

Set to 3 for stop due to free-run
Set to 4 for deceleration and stop

PO48 | Action on Metwork
Idle Mode

Set to O for inverter trip (Default)
Set to 1 for deceleration and frip

Set to 2 for no action
Set to 3 for stop due to free-run

Set to 4 for deceleration and stop

P044 parametresinden haberlesme kopmasi halinde hata vermesi i¢in gerekli siire saniye

olarak belirlenir. (2.00)

P045 parametresinden hata olugsmasinda siiriicliniin nasil davranacagi belirlenir. (0)

A001 parametresinden frekans kaynagi secilir. Ethernet/Ip opsiyon karti ile ag

tizerinden frekans belirlenecek ise “4: Option Card ” se¢ilmelidir.

A002 parametresinden Run komutu kaynagi segilir. Ethernet/Ip opsiyon karti ile ag

tizerinden frekans belirlenecek ise “4: Option Card ” segilmelidir.

CX-Drive’da fabrika avarlarinda olan bir

invertoriin _parametrelerinde vapilmis

degisiklikleri asagida gorebilirsiniz:

Status  Index Description Value Drive V... Default Range Units
ADD1 Frequency Reference Selection 1 4: Option Card — 1 0 to 10
AD0Z2 RUM Command Selection 1 4: Option Card — 1 1to4
c1oz2 Reset Selection 3: Resetting only frip — 0 0 to3
) d080.0  Fault Counter i — ] 0 to 65535 Time(s)
] did1.1 | Fault Monitor 1 (factor) 69: Option error 9 — ] 0 to 255
] d0g1.2 | Fault Monitor 1 (inverter status) 1: Stopping — ] 0 to 255
"] d081.5 |Fault Monitor 1 (voltage) 302.2 = 0.0 0.0 to 1000.0 |V
& d081.6 | Fault Monitor 1 {running time) 28 — i 0 to 1193028 | Hour(s)
" d0581.7 | Fault Monitor 1 (power-on time) 477 — 0 0 to 1193028 | Hour(s)
] Foo1 Output frequency setting 10,00 = 0.00 0,00 to 50.00 Hz
] HO33 Motor 1 Parameter Io (Auto-tuning Data) 1.13 -— 0.3 |0.01 to 855,35 A
" H233 Motor 2 Parameter Io (Auto-tuning Data) 1.13 —_ 0.73 |0.01 to 855.35 A
. Po44 Comrmunications Error Detection Timer Seting 2.00 —_ 1.00 |0.00 to99.99 |Sec
i P045 Operation at Host Communications Error Selection | 20 Ignoring errors -— 0 0tog
) POG2 Position data at power off -795972 — ] -268435455 ...
P185 CAMOpen Mode address p - 0 0 to 127
E P136 CAMOpen com speed 0: Automatic -— [ 03
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4. Sysmac Studio’da NJ501’¢e IP atama

Sysmac Studio’da cihaz tanimlandiktan ve proje baslatildiktan sonra Ethernet/IP ayarlar

asagidaki gibi yapilmalidir.

Built-in Ethernet/IP Port Settings meniisiine gelinir ve cihazin Ethernet/IP ayarlar yapilir.

Cihaza online olunduktan sonra ayarlar senkronize edilir ve IP bilgileri cihaza gonderilir

File Edit View Insert Project Controller Simulation Tools Help

| a5 @

Multiview Explorer

‘new_ControlIer_O v TCP TCP
— /P /1P
il Configurations and Setup
= EtherCAT ¥ |P Address
= CPU/Expansion Racks © Fixed setting
»- CPU Rack (IEY [ [E0l 192 . 168 . 250 . 1
- Power Supply : NJ-Px3001 TGOV ELIE 255 . 255 . 255. _0
<1 CPU : NJ501-1500 Default gateway |
=1 Units @ Obtain from BOOTP server.
= 1/0 Map @ Fix at the IP address obtained from BOOTP server.
va Controller Setup v DNS

-n Operation Settings
- DNS O Do not use [ )

= = Priority DNS server
»= Motion Control Setup S d -
_ . econdary server
« Cam Data Settings Dormain name _

- Event Settings
» Task Settings ¥ Host Name - IP Address

= Data Trace Settings Host Name

T | [
'nPOUS sSnAmp

*# Programs -F’C'l'Is
v= Program0

= Section0 PH

5. Sysmac Studio’da tag olusturma

Ethernet/IP tlizerinden haberlesme saglanacak degiskenler tag olarak adlandirilir, bu
tagler Sysmac Studio’da global degiskenler (Global Variables) icerisinde tanimlanir ve
“Network Publish” siitununda Input ya da Output olarak ayarlanir. Bu ayarlar yapilirken
gonderilecek veriler Output, gelecek veriler Input olarak ayarlanmalidir. Haberlesmede

kullanilmayacak degiskenler ise “Do not publish” olarak secilmelidir.

“At work for a better life, a better world for all...”
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B NJ_EIP - new_Controller_0 - Sysmac Studio

File Edit View Insert Project Controller Simulation Tools Help

| a6 w

Multiview Explorer

revn eatile R Data Type | Initial Value | AT | Retain | Constant | MNetwork Publish |
ARRAY[0..3] OF BYTE

4 Configurations and Setup ARRAY[0..3] OF BYTE
M Programming

va POUs

v Programs

v= Program0
= Section0

= Functions

= Function Blocks
v~ Data

= Data Types

o

»m Tasks

MX IN ve MX OUT degiskenleri Global Variables’ta 4 byte’lik birer array olarak
tanimlanmistir (DWORD olarak da tanimlanabilir). 4 byte olarak ayarlanmasinin sebebi
MX2 invertoriin eds dosyasindaki Speed Control IO (21/71)’in bu boyutta olmasidir. En
son boliimde bu array’lerin igerigi degistirilerek siiriicliye gonderilen ve siiriiciiden

alinan veriler incelenecektir.

B-2 Extended Speed Control 10 (21/71)

Assembly ID 21: Extended

Speed Control Output Table B-5 Extended Speed Control Output - Assembly 21 Allocation

Word | Byte Bit Allocation
Bit7 | Bit 6 | Bit5 | Bit4 | Bit3 | Bit2 | Bit1 Bit0
n 0 - REF |CTR |- - RST REV |FWD
1 - - - R - R R -
n+1 |2 Rotational Speed Reference (Low Byte)
3 Rotational Speed Reference (High Byte)

Assembly ID 70: Basic

Speed Control Input Table B-3 Basic Speed Control Input - Assembly 70 Allocation

Word | Byte Bit Allocation
Bit7 | Bit 6 | Bit5 | Bit4 | Bit3 | Bit2 | Bit1 | Bit0
n 0 - - - - - DFR - FLT
1 - - - - - - - -
n+1 2 Rotational Speed Monitor (Low Byte)
3 Rotational Speed Monitor (High Byte)

“At work for a better life, a better world for all...”
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Sysmac Studio’da Tools>Export Global Variables>Network Configurator

menii/secenekleri ile bu taglar .csv uzantili bir dosyaya (“MX2-NJ-Tags.csv’) aktarilir.

ST JLUI

Import ST Program...

Tools Help
I Backup *
B Export Global Variables 5 Network Configurator...
g Comments for Variables and Data Types * CX-Designer...

Opticn...

| Imitial Value |

6. Network Configurator ile tag tanimlama

Oncelikle asagidaki linkten MX2 igin eds dosyasini indiriniz:
https://industrial.omron.com.tr/tr/products/mx2#downloads

Network Configurator programi acilarak 3G3MX2 icin gerekli .eds dosyasinin
eklenmesi gerekmektedir. EDS File > Install meniisiinden indirilen eds dosyas1 i¢indeki
baglanilacak siiriicli dosyasi segilir (bu Ornekte dosya adi “3G3AX-MX2-EIP-
AB002_A2002-E.eds” dir).

Bu ornekte NJ501-1500’¢  bilgisayar {izerinden ethernet portu {izerinden
baglanilacagindan Option > Select Interface > NJ/NX/NY Series Ethernet Direct I/F

secenedi secilir. Farkli plc’ler i¢in port se¢imleri bu mentiden goriilebilir.

QUntitIed - Network Configurator
File Edit View Network Device EDSFile Tools Option Help

DEEl 82| & a4 e s ¢ EEEEX 2 use/serial Port A
= e g | Edit Conhguration File CS/C)1 Serial Port -> EIP Unit I/F
. > | 4% | 4w | da Ethernet I/F
Setup Monitor Refresh Timer Ethernet -> CS/CJ1 ETN-EIP Unit I/F
£} Network Configurator Install Plugin Module 0 NJ/NX/NY Series Ethemet Direct |/F
- & EtherNet/IP Hardware NJ/NX Series USB Port

- (@ Vendor Install Interface Module

- (= OMRON Corporation
Sl AC Drive Device
%] 3G3AX-MX2-EIP-AB002 A20C...,

Update Parameter automatically, when Configuration was changed
Update Device Status automatically, when it was connected on Network

“At work for a better life, a better world for all...”
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Network > Connect meniisiinden agilan pencerede (Select Connect Network Port)

asagidaki islemler yapilarak agdaki aygitlar goriintiilenir:

TCP:2 segilir ve OK tiklanir..

Select Connect Network Port x
Select a network port that you would like to connect.

Browse

+ BackPlane
A TCP:2

Device Information

Vendor ID : Product Name :
Device Type . Revision :
Refresh Option...

0K | Cancel

Acilan sonraki pencerede asagidaki gibi Ethernet/IP agi segilip OK tiklanir.

Select Connected MNetwork ﬁ

Please zelect a network where the connected network, was supparted.

Target Metwork,

() Create new network.

@ sze the existing network,

Ethertet/F_1 -

“At work for a better life, a better world for all...
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Network > Upload segilerek ag taranir; NJ501-1500 igin 192.168.250.1 ve 3G3AX-
MX2-EIP-A i¢in 192.168.250.2 cihazlar goriintiilenir.

Target Device X
3G3AX-MX2-EIP-A

Address /

192.168.250.2%

192.1 88.250.1\
NJ501-1500

Add... Edit... Delete Off-line Device

OK Cancel

OK tiklanarak parametreler ve ayarlar Network Configurator’e ag tizerinden yiiklenir.

Ag yiikleme islemi bitince Network Configiirator su sekilde goriintiilenmis olur:

@ EtherNet/IP_1

2
a. iy
= -

192.168.250.2 192.168.250.1
3G34X-MX2-EIP-4  NJS0T-1500
BO02_A2002-E 1

=

NJ501-1500 tizerine ¢ift tiklanir ve “Connections” bdliimiinden “Tag Sets” boliimiine
gecilir. Sol alt boliimdeki “To/From File>Import from File” segenekleriyle daha
onceden Sysmac Studio’dan digar1 aktarilan “.csv” uzantili tag dosyasi (“MX2-NJ-

Tags.csv”) projeye eklenir.

“At work for a better life, a better world for all...”
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Edit Device Parameters : 192.168.250.1 NJ501-1500 X
S
In -Consume  Qut - Produce
Name Fault ... Size Bt ID
New... Edt... Delete BExpand All Collapse Al
Edit Tags... Delete all of unused Tag Sets | sage Count : 0/32 Import To/From File
Export to File...
0‘ Import from a

Daha sonra ayni pencerede “Connections” bolimiine tiklanir ve asagidaki resimde

gosterilen “1” no’lu ikona tilanarak 3G3 AX-MX2-EIP kayitl cihazlar arasina gegirilir.

Edit Device Parameters : 192.168.250.1 NJ501-1500 X
Connections  Tag Sets

Unregister Device List

=3 Product Name

I 1192.168.250.2 3G3AX-MX2-EIP-AB002_A2002-E

N

Connections : 0/32(0:0,T:0) [& || =
Register Device List

Product Name 192.168.250.1 NJ501-1500 Variable Target Variable

New... Edit... Delete Edit All... Change Target Node ID... To/From File
Cancel

“At work for a better life, a better world for all...”



[Omron Teknik Destek] MX2-NJ Ethernet/IP Haberlesmesi

“1” no’lu islem ile bu pencerede “Unregister Device List”ten “Register Device List”e
gecirilen “192.168.250.2” IP no’lu 3G3AX-MX2-EIP aygitina ¢ift tiklanarak agilacak

pencerede taglar asagidaki gibi eslestirilir.

192.168.250.2 3G3AX-MX2-EIP-AB002_A2002-E Edit Connection x

It will add a connection configuration to originator device.
Please configure the Tag Set each of originator device and target device.

Connection I}0 Type : | Basic Speed Control «1
Originator Device Target Device
Node Address :  192.168.250.1 Node Address :  192.168.250.2
Comment: NJ501-1500 Comment: 3G3AX-MX2-EIP-AB002_A2002-

Input Tag Set : Edit Tag Sets Output Tag Set:

MX_OUT - [4Byte] v | 2 *“‘ 3 | Input_71 - [4Byte] v
Conneciior! Multi-cast connection ~
Type :
Output Tag Set : Edit Tag Sets Input Tag Set :
MX_IN - [4Byte] v'| 4 * 5| Output_21 - [4Byte] v
Connection |point o Point connection v
Type :
Hide Detail

Detail Parameter
Packet Interval (RPI) : 500 s (2.0-3200.0 ms)

" . ... Connection Name :
Timeout Value : Packet Interval [RPI) x 4 {Possible to omitl

Connection Structure
£» 192.168.250.1 NJ501-1500 *

Yukaridaki ayarlar yapildiktan sonra en son Regist ve Close secilerek Edit Connection

penceresi kapatilir.

Network > Download secenegi ile ayarlanan bu tagler ve parametreler NJ501-1500’e

yiiklenmis olur.

“At work for a better life, a better world for all...”
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7. Sysmac Studio’dan Siiriiciiye Run verme

Output_21 data yapisina gére MX IN[O]’n ilk biti ileri (FW), ikinci biti geri (RV),
t¢ilincti biti reset (RST) komutlaridir. 5.(CTR) ve 6. (REF) bitleri Run ve Frekans

komutlarmin network iizerinden gittigini belirtir ve 1 olarak atanmalidir. Ornegin Ileri

yonde Run komutu verebilmek icin MX_IN[0] = #61 , geri yonde Run komutu i¢in #62

girilmelidir. Stop komutu i¢in MX_IN[0] sifirlanabilir. MX_IN[1] kullanilmamaktadir.
MX_IN[2] ve MX_IN[3] ise frekans referansi i¢indir.
Ornegin; 25.00Hz (#09C4) igin MX_IN[2] = #C4 ve MX_IN[3] = #09 girilir.

B-2 Extended Speed Control 10 (21/71)

Assembly ID 21: Extended
Speed Control Output

MX_IN[O]
MX_IN[1]
MX_IN[2]
MX_IN[3]

Note

Table B-5 Extended Speed Control Output - Assembly 21 Allocation

Word | Byte Bit Allocation
Bit7 | Bit 6 | Bit5 | Bit4 | Bit3 | Bit2 | Bit1 | Bit0
n 0 - REF CTR |- - RST REV FWD
1 - - - - - - - -
n+1 |2 Rotational Speed Reference (Low Byte)
3 Rotational Speed Reference (High Byte)
Table B-6 Extended Speed Control Output - Assembly 21 Description
Name Description
FWD Forward run command
0: Stop
1: Forward run
REV Reverse run command
0: Stop
1: Reverse run
RST Fault reset
Reset fault / trip condition on transition from 0 to 1
CTR NetCtrl run command selection
0: Setting of inverter parameter A002
1: Network controlled
REF NetRef speed reference selection
0: Setting of inverter parameter A001
1: Network controlled
Rotational Reference rotational speed. Unit: [RPM]/[0.1 Hz]/[0.01 Hz].
Speed Refer-
ence If Motor poles setting for RPM (inverter parameter P049 is set to
zero, the Unit depends on the inverter mode (d060):
d060 = 2 (High Frequency mode): Unitis [0.1 HZ]
d060 != 2 (High Frequency mode): Unit is [0.01 Hz]

For safety reasons, the FWD, REV and RST command operation requires a

rising edge (0 to 1 transition) after power on and fault/trip reset.

“At work for a better life, a better world for all...”
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Input_71 data yapisina gore MX_OUT[0-4] adreslerinden okuma islemi yapilabilir.
Bunun igin  MX OUT[2-3]’den anlik frekans degerini  okuyabiliyorken,
MX_QOUTI[0]’iin 0.biti hata; 1. biti uyari, 2. ve 3.bitleri ileri/geri run bilgisi ve 4.biri
siirici  hazir bilgisidir. Diger bitlerin tanimlar1 asagidaki tabloda verilmistir.
MX_QOUT]I1] ise invertoriin durumu bilgisidir (Drive State), bu durum bilgileri tabloda
belirtilmistir.

Assembly ID 71: Extended

Speed Control Input Table B-7 Extended Speed Control Input - Assembly 71 Allocation

Word | Byte Bit Allocation

Bit7 | Bit 6 | Bit5 | Bit4 | Bit3 | Bit2 | Bit1 Bit 0
MX_OUT[0] n 0 ARF RFN CFN RDY | DRR | DFR WR FLT
MX_OUTI[1] 1 Drive state
MX_OUT[2] n+1 2 Rotational Speed Monitor (Low Byte)
MX_OUT[3] 3 Rotational Speed Monitor (High Byte)

Table B-8 Extended Speed Control Input - Assembly 71 Description

Name Description

FLT Fault
0: Normal
1: Fault/trip

WR Warning
0: Normal
1: Warning

DFR During forward run
0: Stop/reverse
1: During forward run

DRR During reverse run
0: Stop/forward
1: During reverse run

Table B-8 Extended Speed Control Input - Assembly 71 Description (continued)

Name Description

RDY Inverter ready status
0: Inverter not ready
1: Inverter ready

CFN Ctrl from net: run command input selection
0: Local
1: EtherNet/IP reference

RFN Ref from net: speed reference input selection
0: Local
1: EtherNel/IP reference

ARF At reference
0: Acceleration or deceleration phase
1: At reference

Drive State Drive State

: Startup

: Not ready

- Ready

: Enabled

: Stopping

. Fault / trip stop

: Faulted / tripped

Rotational Actual rotational speed monitor. Unit: [RPM]/[0.1 Hz}/[0.01 Hz].
Speed Monitor

N O WM =

If Motor poles setting for RPM (inverter parameter P049 is set to
zero, the Unit depends on the inverter mode (d060):

d060 = 2 (High Frequency mode): Unitis [0.1 Hz]

d060 != 2 (High Frequency mode): Unit is [0.01 Hz]

“At work for a better life, a better world for all...”
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Ornek olarak ladder ile program yazmadan izleme penceresinden (Alt+4) MX_IN[0-4]
ve MX2_OUT[0-4] adresleri eklenerek siiriiciiye gonderilen ve alinan veriler asagida
listelenmistir.

Device name | NEE | Online value Modify | Comment | Data type

new_Controller_0 MX_IN[O]
new_Controller_0 MX_IN[1] 00 BYTE
new_Controller_0 MX_IN[2] c4 BYTE

new_Controller_0 MX_OUT[0] F4 BYTE
new_Controller_0 MX_OUT[1] 04 BYTE
new_Controller_0 MX_OUT[2] c4 BYTE

new_Controller_0 MX_OUT[3] 09 BYTE

new_Controller_0 MX_IN[3] 09 BYTE

Siiriicti ileri yonde ¢aligmasi i¢in MX_IN[0] = #61 ; MX_IN[1] = #00 girilir. Frekans
referans1 25.00Hz igin (#09C4) MX_IN[2] = #C4 ; MX_IN[3] = #09 girilmistir.
Invertér Run’da iken MX_OUT[0]’da ARF, RFN, CFN, RDY ve DFR bitlerinden 1
okunmustur. Agiklamalar1 yukaridaki Table-7 Extended Speed Control Input
boliimiinden incelenebilir. MX_OUT[2-3] ise ¢ikistaki anlik frekanstir; rampa siiresi
tamamlandigi i¢in #09C4 (25.00Hz) okunmustur.

Ladder ile yapilan 6rnek yukaridadir. Program ile 25.00Hz veya 50.00Hz referans
bilgisi MX_IN[2-3] e atilabilir. Ileri/Geri yonde Run bilgisi ve Stop bilgisi (MX_IN[O-
1]°‘e MOV Konutu ile gonderilebilir.
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